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Modul 1: Pengenalan kepada Office 365 
 

Office 365 merupakan sebuah pakej perisian yang menawarkan perkhidmatan untuk menguruskan e-mel, kalendar, 
kenalan, dokumen, mesyuarat dalam talian, laman web awam dan banyak lagi. Bagi staff, mereka boleh menikmati 
kemudahan yang ditawarkan oleh Office 365 secara percuma sekiranya institusi mereka membuat langganan. Terdapat 
pelbagai kemudahan yang ditawarkan bagi pakej pendidikan Office 365. Antaranya ialah: 

• Pakej Perisian Office atas Talian (Word, Excel, PowerPoint dan lain-lain) 
• Perkongsian dan storan fail atas talian (1TB bagi setiap staff) 
• Mesyuarat atas talian tanpa had (beserta sidang video HD) 
• Laman Intranet diantara rakan dalam institusi yang sama 
• Laman Sosial diantara rakan dalam institusi yang sama 

Bahagian seterusnya akan menunjukkan bagaimana anda boleh mula menggunakan perisian Office 365 setelah jabatan 
melanggan pakej pendidikan Office 365. 

 
Mengaktifkan akaun Office 365 

 
1. Permulaan, pergi ke portal Office 365 melalui pelayar sesawang (seperti Internet Explorer, Google Chrome dan 

lain-lain) dan masukkan pautan tersebut: 
http://portal.office.com/ 
 

 
 

2. Kemudian, daftar masuk dengan menggunakan ID pengguna dan kata laluan sementara yang diberikan oleh 
Pentadbir ICT. Pada kali pertama anda mendaftar masuk, anda akan diminta untuk mengubah kata laluan anda. 

3. Bagi staff tetapan akaun staff adalah login: id 1govuc@moe.gov.my dan katalaluan : (yang telah diberi oleh 
Pentadbir ICT) 
Jika terlupa katalaluan sila rujuk pada pentadbir ICT jabatan. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://portal.office.com/
mailto:id%201govuc@moe.gov.my


Mukasurat 5 | 31 
Manual Penggunaan Office 365 

4. Setelah mengubah kata laluan, anda perlu log masuk semula ke dalam portal Office 365 dengan menggunakan 
kata laluan yang baharu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Berikut merupakan laman utama bagi Off ice 365 setelah log masuk ke akaun anda. 
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Menjelajah Office 365 

1. Setelah anda mendaftar masuk ke akaun Off ice 365, anda akan masuk ke laman utama portal tersebut. 
 

 
 
 
 
 
 
 
 
2. Pada sebelah atas, terdapat menu yang membolehkan anda terus ke aplikasi yang anda inginkan dengan satu 

klik sahaja sahaja seperti Word, Excel dan sebagainya. 
 

 
 
3. Outlook Web App adalah aplikasi bagi emel, kalendar dan direktori kenalan. Dengan menggunakan aplikasi 

tersebut, anda bolehlah: 
 

 Menghantar dan menerima emel. 
 Mewujudkan temu janji dan peringatan. 
 Menambah informasi mesyuarat Skype kepada jemputan mesyuarat. 
 Menetapkan Outlook atau mana-mana program emel untuk mengakses emel, kalendar dan kenalan Office 365 anda. 
 Mengimport emel dan kenalan dari akaun lama anda. 

 

4. Anda boleh menukar tetapan akaun di laman utama Off ice 365. Klik Settings  > Update Contact 
Preferences settings. 

 Perkara yang boleh dilakukan pada tetapan akaun peribadi adalah seperti yang berikut: 
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Memasang perisian 

Office 365 merupakan sebuah perisian atas talian, dan anda boleh mengakses portal Office 365 di mana sahaja asalkan 
mempunyai liputan internet. Walau bagaimanapun, anda boleh memasang sesetengah perisian yang ditawarkan bersama 
Office 365 di komputer atau peranti mudah alih anda. Perisian yang ditawarkan adalah berdasarkan kepada pakej 
langganan dari jabatan. Terdapat institusi yang boleh memuat turun pakej perisian Office yang terkini. 
Walaubagaimanapun, pakej perisian Skype terdapat di dalam kesemua pakej Off ice 365. 

 
1. Anda boleh memuat turun pakej office terkini pada akaun anda dengan klik ke Settings  > Update Contact 

Preferences settings > Apps & Devices > Off ice. 
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Modul 2: Penggunaan Office Online (Word, PowerPoint dan OneNote) 

Pengenalan 

Office Online adalah sebahagian daripada fungsi yang terdapat di dalam pelan Office 365. Office Online (sebelum ini 
dikenali sebagai Office Web Apps) merupakan satu pakej perisian dalam talian yang ditawarkan oleh Microsoft yang 
membolehkan pengguna bukan sahaja mengakses, malah mencipta dan mengemaskini Aplikasi Microsoft office seperti 
Word, Excel, PowerPoint dan OneNote secara dalam talian. 

 
Microsoft Word Online 

1. Permulaan, pergi ke portal Office 365 melalui pelayar sesawang (seperti Internet Explorer, Google Chrome dan 
lain-lain) dan masukkan pautan tersebut: 

 
2. Pilih menu       > New blank document. 

  

3. Antara muka dokumen Word Online adalah seperti yang berikut: 
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Simpan Dokumen yang telah dicipta dan dikemaskini 
 
Dokumen Word Online disimpan secara automatik. Melihat pada bar status di bahagian bawah Word Online, ia akan 
menunjukkan sama ada sedang disimpan atau telah disimpan. 

 

Kongsi dokumen dalam talian 
 

Untuk berkongsi dokumen secara dalam talian, klik File > Share > Share with people atau pun klik butang  
 

 
Menyunting Dokumen Word 
 
Jika anda cuba untuk menaip di dokumen dan tiada apa-apa yang berlaku, anda mungkin berada dalam keadaan 
reading view. Tukarkan kepada editing view. Klik butang Editing> Pilih Editing. 

 

 

 

 

 

 

Anda bolehlah menyunting dokumen dengan menaip dan format teks, tambah gambar, menyesuaikan susun atur 
halaman dan banyak lagi. Untuk menyunting dengan lebih lanjut, tekan Open in Word. 
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Menyunting Dokumen Bersama Pengguna Lain 
 
Anda boleh menyunting dokumen secara bersama-sama dengan pengguna yang lain di Word Online. Jika terdapat 
pengguna lain yang sedang menyunting, Word Online akan memberitahu tentang penyuntingan tersebut. Anda dapat 
lihat sesiapa sahaja yang tengah bekerja pada dokumen tersebut dengan klik di reben tersebut. 

   
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Klik pada nama pengarang untuk mengetahui dimana mereka bekerja dan kita akan dapat melihat perubahan yang 
dilakukan oleh mereka. Mereka boleh melakukan pekerjaan tersebut melalui Word Online ataupun aplikasi Office yang 
terdapat pada komputer mereka. 

Menambah header atau footer 

Pergi ke tab Insert > Header & Footer untuk menambah headers dan footers ke dokumen. 
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Klik Options untuk memilih cara-cara yang anda inginkan untuk item tersebut muncul. 
  
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 
Menambah bilangan muka surat 

 
Klik Insert > Page Numbers dan pilih dari galeri di mana-mana anda ingin nombor muka surat tersebut untuk muncul. 

  
 

 

 

 

 

 

 

 

 

 

 

 

Pilih Include Page Count untuk menunjukkan nombor halaman semasa bersama-sama dengan jumlah bilangan muka 
surat. 

 

Mencari dan menggantikan teks 
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Cari perkataan atau frasa tertentu dengan cepat di dalam dokumen dengan menekan tab Home > Find (or type Ctrl+F). 
Keputusan akan keluar di sebelah dokumen supaya kita boleh melihat istilah ini di dalam konteks itu. Klik pada hasil 
carian untuk mendapatkan keputusan tersebut. 

 
Mencetak dokumen Word Online 
 
Pergi ke tab File > Print. Word Online akan mencetak kepada PDF untuk dokumen dan akan menyimpan semua susun 
atur dan format dokumen tersebut. Seterusnya, ia akan menghantar PDF ke mesin pencetak dan cetakkan dokumen akan 
bermula. 
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Microsoft PowerPoint Online 
 
Dengan menggunakan PowerPoint Online, kita dapat mencipta persembahan secara dalam talian di pelayar internet. 
Secara automatik dokumen PowerPoint yang dihasilkan akan disimpan di dalam OneDrive, dan kita dapat menyunting 
dan berkongsi secara atas talian tanpa menggunakan mana-mana perisian atau pemasangan tambahan yang lain. 

 
Memilih tema 
 
PowerPoint mempunyai pelbagai tema, set yang direka secara professional warna dan susun atur. Hanya memilih tema 
dan semua slide anda mengikut rupa yang anda inginkan. 

 
1. Pada tab Design, dan seterusnya pilih tema yang anda suka. 

 
 
 
 
 
 

2. Setiap tema mempunyai variasi yang tersendiri. Jadi, anda boleh memilih skema warna yang berbeza. 
 

 
Pilih susun atur untuk slaid anda 
 
Setiap susun atur slaid mempunyai ruang untuk teks, gambar, carta, bentuk dan sebagainya. Pilih susun atur yang 
terbaik bersama dengan pelan yang anda mahu tunjukkan. 

 
1. Di tab Home, klik Layout 

 
 
 
 
 
2. Pilih Layout dan klik Change Layout. 
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Menambah gambar 
1. Pada Tab Insert, klik Picture. 

 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Klik pada butang Choose File dan pilih gambar. Seterusnya klik Open dan klik Insert. 

 

 

 
 
 
 
 
 
 
 
Menambah Animasi Peralihan pada slaid 
Pada tab Transitions, pilih Transition. Untuk menambah peralihan ke semua persembahan slaid, tekan Apply to All. 
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Kongsikan Slaid anda secara dalam talian 

 
1. Klik tab File > klik Share ataupun klik butang  
2. Di bawah bahagian Share, klik Share with people.  

 
 Jika anda ingin menyuruh kenalan anda melihat dan menyunting pembentangan tersebut, klik butang Anyone 

with the link dan klik pada kotak Allow editing. Jika tidak, pembentangan dalam mode view-only. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Salin pautan tersebut dan kongsikan melalui emel atau media sosial. Klik Close. 

 

Cetak slaid anda 

 
1. Pada tab File > Print > Print Full-page Slides. 

 

2. Untuk melihat persembahan apabila ia telah ditukar kepada PDF, klik Open a printable PDF of your document. 
 
3. Tetapkan pilihan susun atur cetak yang anda mahu dan klik Print. 
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 Microsoft OneNote 
 

OneNote telah direka sebagai buku nota versi elektronik. Microsoft OneNote adalah sebuah aplikasi untuk mengambil 
nota dan menguruskan informasi peribadi di mana ia boleh mengumpul, menyusun dan berkongsi informasi bersama 
pengguna lain. Disamping menyimpan nota teks, gambar, audio dan isi kandungan, OneNote boleh mengumpul dan 
menyusun informasi dan seterusnya memudahkan untuk pencarian dan kongsi maklumat dengan pengguna yang lain. 

 
Dengan menggunakan OneNote dalam talian, anda boleh menggunakan pelayar web anda untuk mencipta, membuka, 
melihat, menyunting, format, dan berkongsi buku nota OneNote yang anda simpan pada OneDrive. Jika organisasi anda 
mempunyai pelan atau laman SharePoint Office 365, anda bolehlah menggunakan OneNote Online dengan mewujudkan 
atau berkongsi komputer riba di storan di laman anda. 

 

Mewujudkan notebook baharu 
Daftar masuk ke OneDrive atau laman kumpulan anda dan buat buku nota menggunakan pelayar. Klik             
namakan buku nota tersebut dan klik Create. 

 

 
 
 
 
 
 
 
Taip atau tulis nota menggunakan pelayar 
OneNote Online membolehkan anda menyunting buku nota OneNote secara atas talian melalui pelayar web dan 
kemudiannya menambah teks, gambar ataupun video. Semua kerja anda disimpan secara automatik dan berterusan. 

 
Tab sepanjang sisi kiri skrin mewakili muka surat, yang dikumpulkan ke dalam bahagian, untuk membantu anda 
menyusun dokumen atau item anda. 
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Jika anda cuba untuk menaip dalam buku nota dan tiada apa-apa yang berlaku, anda mungkin dalam Reading View. 
Tukar ke Editing View dengan klik butang Open in apps dan klik Resume editing here.  

 

 
 
 
  
 
 
 
Menambah Gambar 
Dengan OneNote Online, anda boleh memasukkan gambar atau klip seni dengan mudah ke dalam nota anda. 

 
1. Pada mana-mana halaman, letakkan kursor di tempat yang anda mahu untuk memasukkan gambar. 

 
2. Klik Insert dan kemudian lakukan salah satu daripada berikut: 

 Klik Picture untuk memasukkan fail gambar dari komputer anda. 
 
 
 
 
 
 
 
 
 
 
 
 

 Klik Clip Art untuk mencari dan memasukkan gambar dari storan imej Off ice dan klik butang Insert. 
 

 
Menambah jadual 
Jadual adalah cara yang baik untuk mempersembahkan maklumat didalam nota anda. Untuk membuat jadual dalam 
OneNote Online, mulakan dengan melukis grid yang mudah. 

 
1. Klik Insert > Table. 

 
2. Gerakkan penunjuk tetikus ke atas grid untuk memilih saiz jadual yang anda mahu, dan kemudian klik butang tetikus 

sebelah kiri untuk mewujudkan jadual 
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Untuk mengubah suai jadual, klik kanan di mana-mana sel jadual, dan kemudian klik tab Layout yang muncul pada reben. 
Anda kemudiannya boleh memasukkan dan mengeluarkan baris dan lajur, menunjukkan atau menyembunyikan 
sempadan jadual, menyelaraskan sel-sel jadual dengan cara yang anda mahu dan sebagainya. 

 
 
 
 
 
 
 
 
 
 
 
 

 
Menambah Bilangan Muka Surat 
Anda boleh menambah seberapa banyak halaman (Page) dan (Section) yang anda mahu di dalam ruangan nota anda. 
Salah satu adalah seperti yang berikut: 

 
 Klik +Page, dan kemudian taipkan tajuk halaman di bahagian atas halaman yang baru. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 



Mukasurat 19 | 31 
Manual Penggunaan Office 365 

 Menambah Seksyen 
Bagi mengasingkan notebook anda ke dalam kategori yang berbeza, anda boleh menambah seberapa banyak 
seksyen/bahagian yang anda mahu seperti yang berikut: 

 
 Klik +Section dibawah bahagian paparan, dan kemudian taipkan nama untuk Section baru tersebut. 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Menyimpan nota-nota anda 
OneNote Online tidak mempunyai butang Simpan. OneNote Online menyimpan segala-galanya untuk anda secara 
automatik tidak kira betapa kecil atau besar perubahan yang telah dilakukan. 

 

Kongsi nota OneNote atas talian 
Oleh kerana anda mengakses OneNote secara dalam talian, anda boleh berkongsi dengan menghantar pautan secara 
terus. 
 
 
 
 
 
 
 
 
 
 

 
 

Menggunakan OneNote bersama Pengguna Lain 
Bekerjasama dalam melalui OneNote adalah cara yang terbaik untuk berbincang mengenai idea atau melakukan kajian 
untuk projek kumpulan. OneNote Online membolehkan penguna mengemas kini nota tersebut dan dalam masa yang 
sama dikemaskini oleh pengguna yang lain (yang leha diberikan akses). Anda juga boleh lihat apa-apa yang pengguna 
lain lakukan dengan klik View > Show Authors (klik sekali lagi untuk menyembunyikan nama-nama pengarang). 
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Modul 3: Penggunaan Laman SharePoint Dan OneDrive Bagi  Berkongsi Dokumen dan 
Idea 

SharePoint Online 

SharePoint adalah rangka kerja dan platform aplikasi web yang dibangunkan oleh Microsoft. Dengan menggunakan 
SharePoint, anda boleh membangunkan laman web, laman intranet, menguruskan kandungan dan juga dokumen. Anda 
juga boleh menggunakan SharePoint sebagai satu tempat untuk menyimpan, menyusun, berkongsi dan mengakses data 
yang dijamin selamat. 

 

Mewujudkan laman SharePoint 
 
1. Buka laman SharePoint dengan klik tab icon SharePoint. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Seterusnya, klik pada Create site . Taipkan nama bagi Team site dan Communication site baharu anda dan klik 

butang Next. 
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3. Langkah seterusnya anda dibolehkan untuk mengisi rakan didalam Add members. Klik Finish setelah 
selesai mengisi. 

 

 
4. Klik pada butang Edit. 

  
 
 
 
 
 
 

5. Anda boleh menghapuskan item yang berada pada site anda sekiranya tidak diperlukan. Klik seperti pada 
gambar dibawah dan seterusnya klik ikon Delete > Ok. 
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6. Untuk mengubah susunan Site anda, klik tab ikon dan pilih Section Layout. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Untuk menambah gambar pada Site, klik tab icon 
komputer, alamat atau SharePoint. 

 

 

 

 

 

> Image. Anda boleh memilih gambar daripada 

 
 

 
 
 
8. Untuk menambah teks pada Site, anda boleh menggunakan tool yang terdapat pada tab Text. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 

 

 



Mukasurat 23 | 31 
Manual Penggunaan Office 365 

9. Untuk menambah aplikasi pada Site, klik butang > Add an app. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Pada halaman aplikasi, anda boleh memilih aplikasi untuk diletakkan di dalam Site. Terdapat aplikasi yang 
ditawarkan secara percuma dan berbayar. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
11. Untuk menambah halaman yang baharu, klik butang > Add a page > Create page. Isikan nama halaman 

baharu anda di ruangan yang disediakan. 
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OneDrive 

OneDrive adalah sebuah perisian storan fail dalam talian yang ditawarkan dalam pakej Office 365. Bagi pelan pendidikan, 
pakej yang ditawarkan adalah sama seperti pelan untuk perniagaan. Jika anda menggunakan Office 365, anda akan 
mendapat ruang storan dalam talian sebanyak 1TB untuk OneDrive for Business. 

 
1. Untuk mengakses OneDrive, pilih icon OneDrive pada menu di sebelah kiri atas Laman Off ice 365. 

 
 
 
 
 
 
 

 

2. Untuk menghasilkan atau memuat naik sebarang dokumen, sila guna pilihan yang terdapat di Quick Command 
Bar. 

 
 
 
 
 
 
 
 
 
 
 

 
Mewujudkan folder baharu pada OneDrive 

 

1. Untuk mewujudkan folder baharu pada OneDrive, klik pada ikon 
dan pilih Folder. 

. Beberapa pilihan akan keluar 
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2. Setelah anda klik pada Folder dan satu pop up akan keluar dan meminta anda untuk mengisi nama folder 
tersebut. Klik Create setelah selesai. 

 
 
 
 
 
 
 
 
 
 
 
 

3. Setelah klik Create, anda akan dibawa ke folder yang baharu yang diwujudkan tadi. 
 

 
 
 
 
 
 
 
Memuat naik dokumen ke dalam OneDrive 
1. Untuk memuat naik dokumen ke dalam OneDrive anda, klik ikon                   dan satu pop up akan keluar. Klik 

pada Files. Anda bolehlah memuat naik lebih daripada satu dokumen. 
 
 
 
 
 
 
 
 
 

2. Seterusnya, klik Open 

 
Kongsi dokumen atau folder anda 
1. Untuk berkongsi folder atau fail, klik pada sebelah kiri folder atau dokumen yang anda ingin kongsikan dan klik ikon 

share pada sebelah kanan folder atau fail tersebut. 
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2. Klik ikon          dan satu pop up akan keluar. 
 

 
 
 
 
 
 
 
 
 

3. Taipkan nama kenalan anda di ruangan yang disediakan. Anda bolehlah memilih sama ada kenalan anda hanya 
boleh melihat atau menyunting dokumen tersebut dengan memilih Can edit atau Can view. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Setelah selesai mengisi nama kenalan anda, klik butang Send. Satu notifikasi akan keluar di atas sebelah kanan 
setelah anda selesai berkongsi item tersebut. 
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5. Bagi melihat senarai folder dan dokumen yang telah diberikan akses untuk dikongsi bersama pengguna lain, klik 
Shared > Shared by me. 

 

 
 
 
 
 
 
 
 

6. Bagi menghentikan perkongsian dokumen tersebut, klik pada folder atau file disebelah kiri pengguna 
yang mempunyai akses untuk berkongsi. Seterusnya, klik Manage access. 

 
 
 
 
 
 
 
 
 
 
 
 

7. Seterusnya, paparan Manage Access akan keluar seterusnye tekan icon 
link paparan klik pada Delete link. 

     dan akan memaparkan delete this 
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Modul 4: Penggunaan Outlook Web App Bagi Emel Dan Kalendar 

Pengenalan Outlook Web App untuk Office 365 

Notifikasi, navigasi dan tetapan 
Pada sebelah atas Office 365, anda melihat satu menu yang akan bawa anda ke pelbagai bahagian pada Office 365 anda. 

 
 
 

 
 
 
 
 
 
 

I         tab ini untuk membuat email baru , kalender dan kumpulan. 
 

Status chat, kalendar, biodata peribadi, opsyen dan pertolongan. Guna kawasan ini 
untuk daftar masuk untuk chat dan uruskan status chat, kalender, pertukaran 
biodata peribadi, pergi ke opsyen atau daftar keluar dari akaun anda. 

 
Penggunaan Emel 

 
Menghantar Emel 

 
1. Klik ikon                      pada laman tersebut. Mesej baharu akan muncul pada ruangan bacaan. 

 
 

2. Untuk menambah pengirim, anda perlu menaip nama sesiapa sahaja di dalam folder kenalan atau senarai alamat 
organisasi ataupun menaip alamat emel di ruangan To atau cc. 

3. Tambah tajuk subjek yang ingin anda sampaikan pada ruangan Add a subject dan taip isi kandungan emel anda di 
ruangan yang disediakan dibawah. 

 
4. Untuk mengepil lampiran pada emel anda, klik pada tab Attach. Pilih fail anda dan klik Open. Bagi menambah 

gambar atau tandatangan anda pada emel, anda boleh memilih pictures inline dan insert signature. 
 

 
 
 
 

A 
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5. Untuk membuang lampiran anda, anda bolehlah klik ikon  di sebelah lampiran anda. Untuk memuat turun 
lampiran anda pula, anda perlu klik        > Download.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

6. Klik butang                   untuk menghantar emel anda. 

 
 
Melihat Senarai Emel yang dihantar 

 
Anda boleh melihat senarai Emel anda dengan klik pada Menu Inbox yang berada dibahagian sebelah kiri. Anda juga 
boleh memilih untuk melihat emel yang telah dihantar, dibuang dan sebagainya. 
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Modul 5: Menukar Tetapan Akaun seperti Kata Laluan atau Bahasa di Off ice 365 

Mengubah Kata Laluan 

1. Untuk menukar  tetapan akaun,  anda perlu klik pada butang  Settings   yang terletak di atas sebelah kanan 
laman Office 365 

 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 
 

 

2. Klik Password untuk mengubah kata laluan pengguna. Anda diminta untuk memasukkan kata laluan lama dan 
baharu di ruangan yang disediakan. Kata laluan anda mestilah mempunyai 8-16 karekter dan mempunyai 
campuran huruf besar, huruf kecil, nombor dan symbol dan klik submit untuk menyimpan kata laluan. 
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Menukar Bahasa Office 365 

1. Untuk menukar bahasa di Off ice 365, anda perlulah klik ikon setting di laman Off ice 365 settings. 
 

2. Seterusnya, pilih bahasa yang mudah anda fahami dan klik butang Save untuk mengemaskini bahasa pada 
Office 365 anda. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Nota: Tetapan in tidak digunakan untuk Outlook, Kalendar dan Kenalan. Untuk mengubah tetapan tersebut, di 
bahagian atas halaman, klik Outlook. Pada halaman Outlook Web App, klik Setting > Option > Setting > Rantau 
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